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ABSTRACT

Development in visualization technology is changing the way science is
undertaken in many areas of research. This project is a system specifically designed to
manage and visualize the temperature data of the human body.

Knowledge in certain domains is very important in developing the visualization
of bioheat process system. There are two main areas of research needed to carry out in
order to marks the whole project succeed, research on the visualization program tools
and research on the bioheat process in the human body. As the result of research,
MATLAB was chosen to be the core-programming tool.

An important aspect of this system is to visualize temperature bioheat processes
of heat transfer. The objective of this system is to illustrate how programming, modeling
and simulation of a transient PDE problem using a mathematical software package in
MATLAB.

There are two major categories of user had been determined, which can be
categorized into expert and non-expert user. The user will benefit from this system as it
is visualization and it is repository that is rich in various artificial intelligent and

multimedia contents.
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CHAPTER 1: INTRODUCTION

1.1 Project Overview

This report proposed the development of a system, which is can gain knowledge
about visualization of human body temperature and will include many different
categories of users. This project includes the theoretical modeling of high and low
temperature heat with particular emphasis on phase change phenomena.

The project it also is equipped with easy to understand instructions and very
user-friendly interface, which will attract both computer literate. User can better visualize
the temperature behaviors, and explore the effect of changes in system geometry, and
properties.

Furthermore, this system tries to illustrate the linkage between theoretical concepts
of multidimensional transient heat conduction and computer simulation using MATLAB.,
The resulting parabolic partial differential equation (PDE) is solved using finite difference
method and PDE Toolbox (pdetool). This system considers successively linear system

corresponding to the bioheat transfer problem corresponding to a Pennes” model.



1.2 Objectives of project

The main objective is to develop a system which suitable numerical methods for
visualization of bioheat process The visualization of bioheat process hopes to realize the
following objectives:

I. Theoretical modeling of heat transfers process involves problem solving.

2. Visualizing of temperature in human body with cognitive science principle.

3. To study heat processes - bioheat process in skin burn and hyperthermia (cancer
therapy).

4. To visualize in different ways the temperature values in analyzing the process by

various experts



1.3 Scope of project

The scope of this project is based on the project objectives, This system can use
by expert user (cancer specialist) to visualization of temperature distributions on a very
complicated geometry and non-expert user (patient) to get information in human body
temperature. It has two category user can use this system:

e Expert user — use the system to know the temperature and to determine the
temperature using visualization with arrow, height 3D and contour.
- active decision making to give the treatment based on the
temperature visualization.
e Non-expert — use to determine the temperature using visualization with
colour.
- passive decision making which is just get information using

visualization.
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Figure 1: Scope of the project




This project will be developed using MATLAB programming. This system will
be developed contains all these elements:

e Design high performance computing techniques for computer modeling, data
visualization, and interpretation. A particular application area is bioheat transfer
modeling of biological bodies.

e Have AI element aspect such as cognitive science, decision making and

intelligent multimedia

1.4  Aim of project

The aim of this system is to show the effect of bioheat equations on the thermal
states of biological tissues and to predict the effects of the thermal physical properties on
the transient temperature of tissues and damage function. This system can be very
beneficial in widening the idea of clinical thermal technology and thermal medical

practices.



1.5  Report Overview

Chapter 1- Introduction

This chapter is an overview of the project’s proposal. This includes the objectives,
scope, aim, the importance, and definition of project.

Chapter 2- Literature Review

This chapter includes the literature review of the other works on associated issues and
fields of interest.

Chapter 3- Methodology

This chapter identifies and provides the clarification on the methodology approach that
will be used in this project and methodology to solve the bioheat equation.

Chapter 4- System Analysis

A detailed analysis of the system development tools are covered which include the
practicality and effectiveness of the chosen tools use in this project.

Chapter 5- System Design

This chapter describe the fundamental design such functional design, non-functional
design and also the user interface.

Chapter 6- System Implementation

This chapter reviews on the conversion of system requirements into program codes.
Chapter 7- System 1esting

This chapter describes the testing conducted to determine the errors that occur until the
system is free from errors.

Chapter 8- System Evaluation

This chapter covers the system strength and limitations,



1.6  Project Schedule

In order to organize the development phase of the system, a schedule is essential
in order to develop the system in a more proper manner where the development phase
follows certain time frame allocated. Below is a Gantt chart on the development phase

scheduled along the intended time frame for each phase of the system.

Table 1: Project Schedule Visualization of Bioheat process System.

Key Activities Jun |July | Aug |Sept |Okt |Nov |[Dec |Jan | Feb
04 04 04 04 04 04 04 05 05

Requirement ‘

Literature Review

System Analysis H

System Design

System
Implementation #

System Testing

System Evaluation

Documentation




Chapter
Literature Review




CHAPTER 2: LITERATURE REVIEW

Before starting to design any system, the very first steps are to come across the
literature surveys and gather all the information needed for further development of the
proposed system. There are several ways to retrieve this invaluable information from

various resources.

2.1 Bioheat thermal process in human body

The blood circulation underneath the skin, local metabolism, and heat exchange
between the skin and its environment controls body temperature. Changes in any of
these parameters can induce variation of temperature and heat flux at the skin surface,
reflecting the physiological state of human body. Temperature is a measure of the
tendency of an object to spontaneously give up energy to its surrounding. When two
objects are in thermal contact, the one that tends to spontaneously lose energy is at the
higher temperature. Bioheat modeling is skin burns is the one of the application in heat
transfer analysis.

Heat transfer in human tissues involves complicated process such as heat
conduction in tissues, heat transfer due to perfusion of the arterial-venous blood through
the porous of the tissues (bio-convection), metabolic heat generation, and external
interactions.

Modeling heat transfer within the body requires formulating equations (named
‘bio-heat transfer equations’) for heat transfer phenomena within a tissue and assuming a

simplified geometric body. Such thermal models have been developed for a wide variety



of purposes: the analysis of hyperthermia, the prediction of thermal physiological
responses under a severe condition, and the evaluation of the comfort of a thermal
environment.

Skin surface temperature is greatly influenced by thermal environmental

conditions. Therefore, in order to detect and evaluate an abnormal area from specific

colour, eliminating this influence is required.

9



2.2  Bioheat equation

The thermal structure of the superficial tissues described above can be used as a
basis for calculating tissue temperature profiles and for determining responses to

transient changes in surface conditions. Here a one-dimensional solution to this problem

is provided.
pc@T/@tz div(kgradD-CbW(T-Tb)+Qe Equation (1)

The term on the left-hand side of the equation is the rate of change of thermal
energy contained in a unit volume per unit time. On the right-hand side the three terms
represent the rate at which thermal energy enters or leaves the unit volume in unit time
by conduction, perfusion and metabolism respectively. This heat transfer equation first
suggested by Pennes (1948) is still widely used for heat transfer in biological tissues
although it does presuppose an unrealistic degree of tissue homogeneity. Recently
modifications have been suggested (Lagendijk 1987, Weinbaum er a/ 1984) which go
some way in dealing with the added complexities of local variations in vascular
geometry and blood temperature. The main features Pennes’s bioheat transfer model are

simple, based on uniform perfusion and it is not valid for all tissues.

10



Setting the Parameters
There are nine parameters that need to be set to define the transport problem. The
lines containing the parameter assignments appear in the first cell, at the beginning of
the notebook. Each parameter is described briefly below. Also given are the current
values of each parameter.
P density of tissue
C specific heat of tissue
t time
Cb  specific heat of blood
T tissue temperature
Tb  blood temperature
w perfusion rate

K thermal conductivity of tissue

Qe body heating coefficient

11



2.3 Hyperthermia

Hyperthermia is heat treatment for cancer. One problem with treating cancer
successfully is the fact that cancerous cells are very difficult to target specifically. In
most respects, they are like normal cells, and even if they are not, they can hide the
differences. Raising the temperature of the tumor is one way to selectively destroy
cancer cells. Hyperthermia is usually classified as local, regional, or whole body.

Hyperthermia is dependent on both temperature and time.

Hyperthermia cancer therapy is defined as selective tumor cell killing by local,
regional or whole body heating to temperatures between 41°C and 45°C for a period
ranging from minutes to a few hours and in opposition to the body’s control processes
whose purpose is to maintain the temperature around the normal set. Whole body
hyperthermia (WBH) implies maintaining the body temperature at up to 42°C. For
regional and local hyperthermia, the aim is to achieve temperatures in the range 42° and
45°C. In regional hyperthermia, large portions of the trunk or limbs are heated and often
a difference in perfusion of the tumor and normal tissue is relied upon to produce a
temperature differential. In localized hyperthermia a smaller volume of tissue local to

the tumor is heated.

12



Bioheat transfer

The objective of hyperthermia in cancer therapy is to raise the temperature of
cancerous tissue above a therapeutic value while maintaining the surrounding normal
tissue at sublethal temperature values. It has been suggested that numerical modeling of
the induced temperature distributions would yield a more complete description of the
three dimensional temperature distributions. Modeling the hyperthermia induced
temperature distribution requires an accurate description of the mechanism of bioheat
transfer. It is well known that blood flow affects the thermal response of living tissues.

The heat exchange between the living tissues and the blood network that passes
through it depends on the geometry of the blood vessel, the blood flow through it, and
the properties of the blood and the surrounding tissue. For example, it has been
demonstrated that the presence of large vessels in a heated volume with blood entering
at systemic temperature can be an important source of tissue temperature non-uniformity
and possible hyperthermia under dosage. Considering all the above, tremendous efforts
were focused on describing the temperature field around blood vessels.

The theoretical analysis of heat transfer and the interpretation of the heat
clearance measurements started with the use of the simplified bioheat equation derived
by Pennes, (1948). The bioheat equation is a modification of the well-known transient
heat conduction equation in which the convective effects of the moving blood are treated

as a volumetric isotropic heat source. The metabolic heat generation can be also

included, if needed.

13



Bioheat transfer equation:
pcOT/Ot= div(kgrad T) -Cb W (T -Tb) + Qe Equation (1)

During hyperthermia treatment the tissue temperature grows up to the upper
boundary of the tissue surviving, i.e. up to 44- 46°C, moreover, during a thermotherapy
course based on the thermal tissue coagulation the temperature can attain values about
100 °C. So the question of whether the cellular tissue undergoing so strong heating can
be described in the framework of the passive medium model is not evident. Therefore
the thermal properties of cellular tissue under local strong heating deserve individual
investigations to clarify if the physical background of the bioheat transfer theory has to

be modeled. In particular, the fact that heat propagation in cellular tissue can exhibit

anomalous properties was noted in.



2.4 Visualization

2.4.1 Overview

Visualization simply means presenting information in pictorial form and using
human recognition capabilities to detect patterns. Scientists, engineers, medical
personnel, business analysis, and others often need to analyze large amounts of
information or to study the behavior of certain processes. Numerical simulations carried
out on supercomputers frequently produce data files containing millions data values.
Similarly, satellite cameras and other resources is a large data files that faster than it can
be interpreted. To scan these large sets of numbers to determine the relationship is an
ineffective process. But if the data are converted to a visual form, the patterns are often
immediately clear. To produce graphical representation for scientific, engineering, and
medical data sets and processes is generally referred to as scientific visualization.

There are many different kinds of data sets, and an effective visualization
depends on the characteristics of the data. A collection of data can contain scalar values,
vectors, high-order tensors, or any combination of these data types and data sets can be
2D, or 3D and the colour is just one way to visualize a data set.

Other techniques in visualization are like contour plots, graphs, charts surface
renderings, and visualizations of volume interiors. Image processing techniques are
combined with computer graphics to produce many of the data visualization.

The visualization of the volumetric data has aided many scientific disciplines
ranging from biomedical sciences to distance learning to geophysics. The diversity of

the fields and the growing reliance on visualization has led to its importance, There is so



much emphasis on visualization as it often the most intuitive mode of analysis. Currently

a lot of research is being done for implementing specialized visualization system.

2.4.2 Visualization concept

Visualization is a formation of mental visual images, the act or process of
interpreting in visual terms or of putting into visible form (Colin, 2000). The scientific
visualization is the formal name given to field in computer science that encompasses
user interface, data representation and processing algorithm, visual representation, and
other sensory presentation such as sound and touch.

Visualization is more than a method of computing. It is process of transforming
information into a visual form enabling the user to observe the information. On the
computer science side, it uses techniques of computer graphics and imaging. Besides
relying on visual computing and display, it involves human beings. Thus, we need to
take into account human perception and cognitive capabilities, human variations, task
characteristics and decision-making. Successful visualizations can reduce the time for
the user to get the information, make sense out of it, and enhance creative thinking. In
contrast with most data used in scientific visualization, information is usually non-
spatial or abstract. To create visualization, one needs to map the information into
physical space that will represent relationships contained in the information faithfully
and efficiently. This could enable the observer to use his/her innate abilities to
understand spatial relationships. Finding a good spatial representation of the information

at hand is one of the most defunct tasks in visualization of abstract information.

16



There are several different aspects to user interface for a data visualization
system. These include the following:

e interaction with the visualization process such as modifying parameters
or changing the method of data analysis to look at different views of the
data.

e interaction with the original data collection or computation and the ability
to modify the model , or even the problem.

The reason for having visualization system is to help people solve problem.
Thus, the area of cognitive psychology, which is the study of how people solve
problems, is highly relevant. It has been postulated that the semantics of the
representation of a problem may determine how difficult the problem is to solve. For
example when people are given isomorphic problems (identical in form) but with
different semantic representations, there is little carry over in the problem solution
process. This means that what the user learns in solving the first problems is not used in

solving the second problem, even though they are identical in form, but not in

representation.

17



2.4.3 Data visualization techniques

1.

ii.

iil.

Isosurfaces and Contours

This display technique is best suited for geographical or other physical
object depictions. Contour lines connect data points that have the same
value for a particular parameter in a region of values. Isosurface is a 3D
surface contour, where at each point on the surface, the value of the data
is the same.

Volume rendering

One of the most active areas in advanced data visualization is volume
rendering. Volume rendering is the process of  projecting
multidimensional data set onto a two-dimensional image plane in order to
gain better understanding of the internal structure of the volumetric data
visualization. This technique is most commonly used in the medical field,
geosciences, astrophysics, chemistry, mechanical and other engineering
fields.

Colour Mapping

Colour maps present a relationship between a range of data values and a
range of colours. In this process, each colour is mapped to either a
specific data value or a range of data values. Often a continuous colour
gradient, or colour spectrum, is used in colour maps. Colour mapping is
very useful when applied in conjunction with other visualization
techniques. For example, a colour map can be used with a three-

dimensional plot in order to display a relationship four variables.



1v.

Vector Field Representation

Vector field representation uses a broad set of techniques to depict the
magnitude of data or a direction of flow. These techniques also allow
users to depict two data attributes in a single point. Some of the popular
vector field techniques are streamlines and glyphs. Streamlines illustrate
a general flow and are the lines that are tangential to a velocity field at
each point. Glyphs are generic visual objects, such as a sphere, that are
used to represent data.

Voxelisation

Voxelisation is the process of producing 3D data from an object
description like polygonal meshes, so that each voxel has a value. Voxel
(volume element) is the name given to a value in 3D space. The data can
then be rendered using a volume visualization technique to produce an
image of the original object. Voxelisation is the process of converting an
object of one description into volume data. Appropriate volume

visualization techniques can be applied to any data.

19



2.5 Artificial intelligent aspect

Artificial intelligent (AI) is a branch of computer science applying human

intelligence to computer system.

2.5.1 Different user

Different user whether expert or non-expert can use this system will make the
system is intelligent. The expert is a shown how will the system go with different point
of view. Here three different users had been used, theoretical modeling of bioheat
process, doctor, and patient. Under patient record, doctor may have information like
sickness, normal or abnormal temperature using height 3D, colour, contour, and arrow
technique visualizations. For a patient, they may have information like sickness, normal

or abnormal temperature using color visualizations.

2.5.2 Cognitive science principle

Colour is a visualization techniques used to convey more information. Many
applications used the colouring approach since information can be displayed attractively
to users and can often improve task performance. The appropriate use of colour is very
important for effective visualization because the human eye is least sensitive to the
colour (Collin, 2000) Trichromacy theory explains that most important fact about colour

vision is that we have three distinct colour receptor called cones in our retinas that are

active at normal light level.

20



Visualization amplifies cognition. About six major ways in which the
visualizations can amplify the cognition are:

e increasing the memory and processing resources available to the users.
e used visual representations to enhance the detection of patterns

e enabling perceptual inference operations

e used perceptual attention mechanisms for monitoring

e encoding information in a manipulability medium.

This visualization can allow patterns in the data to reveal themselves and it allow
some inferences to be done very easily. It also allow the environment to store details like
map close to where they need to be used, reduce data search by grouping or visually
relating formation where they can compact information into a small space. Besides that,

it also allows patterns in the data reveal themselves and allows some inferences done

easily.

2.5.3 Decision-making

The management of this system can involve computer’s capability of performing
rapid calculations of the bio-heat equation and data comparison could be used to produce
meaningful information for management to the user whether to non-expert user or
expert user. This system can do a decision-making process to get know what the user
status in temperature based on information of their knowledge.

As the system move toward decentralized decision-making, give the users access

to information they need to make decision. This is to get the solution the bioheat

21



process. Non-management user also benefit by having information available through

modeling and visualization from the information.

2.5.4 Memory and knowledge

Colour mapping can attach the meaning of the temperature in-patient’s which is
will store at long-term memory. Learning colors because it will works with the semantic
memory. Semantic memory contains world knowledge, not skills. This knowledge is
generic and context independent such as colour of the temperature and boundary of

temperature. Semantic use the perceptual categories such as colour are organized such

that prototypes for various colours exist.

2.5.5 Intelligent multimedia

Today multimedia in its different forms penetrates a lot of different
communication environment from a technical point of view multimedia is based on
networked communication (e.g. www) as well as digital store media (e.g. CD-ROM). In
the literature we can find different definitions of multimedia, one of the definition is,
according to Fibiger (n.d), multimedia is the combination of timer-based media, such as
voice, animation and video- a lord with space-based media- such as text, graphics and
images.

Multimedia allows the process of learning to become more exciting and
experienced. It is also helps the person to understand concepts faster and easier. The
usage of multimedia has some importance in the medical process. It gives an opportunity

to the doctor and patient to get knowledge about the human body temperature,

8o
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2.5.6 Numerical method

Partial differential equation such as bioheat equation using Matlab is one part of
the numerical method that include in Al aspect. The PDEs have capability to solve many

problem areas such as engineering problem including heat conduction.

2.5.7 Visualization

Visualization has two aims that are perception and interpretation. Interpretation
aims are defined by the viewer(s), for example identify objects, compare values,
distinguish objects, and categorize objects. Types of interpretation are supported by
classification of data (temperature value) e.g. low, normal, and high temperature. It can
generate meaningful information. Besides that, the user can understand how perception
works, our knowledge can be translated into rules for displaying information. In

addition, visualization can reduce time for user to get the information.



2.6 Matlab

2.6.1 Overview

Matlab is an acronym for Matrix Laboratory and high performance language for
technical computing. Matlab can be used to represent a physical system or a model. It
integrates computing, visualization and programming in a user-friendly environment
where problems and solution are expressed is familiar mathematical notation. Typical
uses of Matlab include:

1. Math and computation

2. Algorithm development

3. Modeling, simulation and prototyping

4. Data analysis, exploration and visualization

5. Scientific and engineering graphics

6. Application development, including graphical user interface building

Matlab is an interactive system which basic data element is an array that does not
require dimensioning. Many technical computing problems, especially those involving
matrix and vector formulations can be such as C or Fontran.

In university environment it is a standard instructional tool for introductory and
advance courses in mathematics, engineering and science. In the industry, it is used for
high-productivity research, development, and analysis.

Matlab also has application specific solutions called toolboxes. Toolboxes are
comprehensive collection of Matlab functions (M-files) that extend the Matlab

environment to solve particular classes of problems. Areas in which toolboxes are



available include signal processing, control systems, neural network, fuzzy logic

wavelets, simulation, and others.

2.6.2 Matlab and other platforms

Matlab allows interaction with data and programs external to its environment. It
provides an Application Program Interface (API) to support these external interfaces.
The functions supported by the API include:

1. Calling C or Fontran programs from Matlab
2. Importing and exploring data to and from the Matlab environment

3. Establishing client/server relationship between Matlab and other software

programs.

2.6.3 The Matlab array

The Matlab language works with only a single object type: array. All Matlab

variables including scalar, vectors, matrices, string, cell arrays, structures and objects are

stored as arrays.
Matlab data types include:
1. Complex double-precision matrices
- These matrices are of type double and have dimension of m-by-n, where m is
the numbers of rows and n is the number of columns, The data is stored as
two vectors of double-precision numbers — one containing real data and the
other imaginary data.
2. Numeric matrices

- These are single-precision, floating print, and 8-, 16-, and 32-bit integers
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both signed and unsigned. The data is store in two vectors in the same
manner as double-precision matrices.
3. Strings
- Strings in Matlab are of type char, and are sound just as unsigned 16-bit
integers are, except that no imaginary data component exists. Each character

in the string is stored as 16-bit ASC11 Unicode.

4. Cell arrays
- Cell arrays are a collection of arrays, where each array is referred to as a
cell. This allows arrays of different types to be stored together. Each cell can

be of any supported data type, even another cell array.

5. Multi-dimensional arrays

- Matlab arrays of any type can be multi-dimensional. A vector of integers is
stored where each element is the size of the corresponding dimension. The
storage of the data is the same as matrices.

6. Logical arrays
- Any noncomplex numeric or sparse array can be flagged as logical. The

storage for a logical array is the same as the storage for a non-logical array.

2.6.4 Matlab graphics

Matlab has graphics features for visualizing data and preparing presentation
graphics. It has routines for building 2D and 3D graphic structures such as line plots,
contour plots, mesh and surface plots, and animation. In addition to this colour, shading,
axis labeling and general appearances can be controlled. Lighting effects, patches, and

control of aspect ratio and display size enhance data output in Matlab,



2.6.5 Partial Differential Equation Toolbox

PDE Toolbox is a graphical user interface (GUI). pdetool provides the
graphical user interface (GUI) for the PDE Toolbox. The GUI helps you to draw the 2-D
domain and to define boundary conditions for a PDE problem. It also makes it possible
to specify the partial differential equation, to create, inspect, and refine the mesh, and to
compute and display the solution from the GUIL

pdetool contains several different modes:

In Draw mode, you construct a Constructive Solid Geometry model (CSG model) of

the geometry. You can draw solid objects that can overlap. There are four types of solid

objects:

« Circle object - represents the set of points inside a circle,

« Polygon object - represents the set of points inside the polygon given by a set of

line segments.

« Rectangle object - represents the set of points inside the rectangle given by a set

of line segments.

« Ellipse object - represents the set of points inside an ellipse. The ellipse can be

rotated.

Typing a set formula can combine the solid objects. Each object is automatically
assigned a unique name, which is displayed in the GUI on the solid object itself. The
names refer to the object in the set formula. More specifically, in the set formula, the

name refers to the set of points inside the object.
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In boundary mode, you can specify the boundary conditions. You can have
different types of boundary conditions on different boundaries. In this mode, the original
shapes of the solid building objects constitute borders between sub domains of the
model. Such borders can be eliminated in this mode. The outer boundaries are color
coded to indicate the type of boundary conditions. A red outer boundary corresponds to
Dirichlet boundary conditions, blue to generalized Neumann boundary conditions, and

green to mixed boundary conditions. You can return to the boundary condition display

by clicking the dQ button or by selecting Boundary Mode from the Boundary menu.

In PDE mode, you can specify the type of PDE problem, and the coefficients c,
a, f and d. You can specify the coefficients for each sub domain independently. This
makes it easy to specify, e.g., various material properties in one PDE model. The PDE to

be solved can be specified by clicking the PDE button or by selecting PDE Specification

from the PDE menu. This brings up a dialog box.

In Mesh mode, you can control the automated mesh generation and plot the
mesh. An initial mesh can be generated by clicking the Abutton or by selecting
Initialize Mesh from the Mesh menu. The initial mesh can be repeatedly refined by

clicking the refine button or by selecting Refine Mesh from the Mesh menu.

In Solve mode, you can specify solve parameters and solve the PDE. For
parabolic and hyperbolic PDE problems, you can also specify the initial conditions, and
the times at which the output should be generated. For eigenvalue problems, the search

range can be specified. Also, the adaptive and nonlinear solvers for elliptic PDEs can be
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invoked. The PDE problem is solved by clicking the = button or by selecting Solve PDE

from the Solve menu. By default, the solution is plotted in the pdetool axes.

In Plot mode you can select a wide variety of visualization methods such as
surface, mesh, contour, and quiver (vector field) plots. For surface plots, you can choose
between interpolated and flat rendering schemes. The mesh can be hidden in all plot
types. For parabolic and hyperbolic equations, you can animate the solution as it changes
with time. You can show the solution both in 2-D and 3-D. 2-D plots are shown inside
pdetool. 3-D plots are plotted in separate figure windows. Different types of plots can

be selected by clicking the button with the solution plot icon or by selecting Parameters

from the Plot menu. This opens a dialog box.



2.7 Summary

Many problems are encountered in the field of volume visualization. Some of

these problems themselves have branched into areas of research. These include:

ii.

il

1v.

i,

Volume visualization system has to be such that it unites numerous
visualization methods.

Visualization from complex data sets.

Aspect of color that can get important knowledge.

Knowledge of human perception can lead to more effective
visualizations.

Bioheat process in the human body.

Hyperthermia as a heat treatment for cancer.
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CHAPTER 3: METHODOLOGY

3.1 Development methodology

A system development methodology or also known as process model is a
collection of procedures, technology, tools and documentation aids which help system
developers in their task of implementing a new information system. It consists of a set of
phases, which consists of a set of sub phases. This shows the way in applying the set of
software process activities and associated result towards producing a software product. It
defines the stages of a system development project, specifies the task to be carried in and
out, and the output is expected from each stage. Methodology provides guideline for the
developers and helps them to plan, manage, control and evaluate info system project.

There are many types of development model in the software engineering, such as
waterfall model, waterfall with prototyping model and spiral model. A good
methodology, which is able to provide the effective ways of system development, is best
defined before the project starts and then becomes the framework to development staff,

Below are some benefits offered by a good methodology:

e Provides a standard framework thal the developer does not have to reinvent the

wheel for each project

e Each method or tool in the methodology results in successful completion of each

development task

e Increase the system quality by enforcing the developer to produce flexible

system and adequate documentatior

e Provides better understanding of user needs and validation of user needs
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e Provides the management with tools to review project progress and checklist to
access tasks and deliverables

e Improves communication among management, analyst, programmers, users and
other stakeholders by providing a communication base

e Facilities planning and controlling the project

I have decided to use the Waterfall Model as my system process approach.

3.1.1 Waterfall Model

The waterfall model is also called the "classic life cycle" or the "linear sequential
model”. The stages of the waterfall model are performed sequentially, in a systematic
fashion. Only after a stage is completed can the next stage begin. However, if errors are
detected during any stage, one can return to the previous stage for corrections.

The waterfall model was derived from engineering models to put some order in
the development of large software products. It consists of different stages, which are
processed in a linear fashion. Compared to other software development models it is
more rigid and better manageable. The waterfall model is an important model, which is
the basis of many other models, however for many modern projects it has become a little

outdated. It is still wildly used.

The Waterfall Model was chosen because of the following reasons:
e Very structured
The system is design using a logical flow.

e Predictable
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It allows estimation of the completion of each stage so that the system
can be developed within the time frame given. Involve user’s
participation. Require information gathering form the user in order to
develop a system hat meet user needs to a greater extend.

* Good visibility

All the requirements can be identified and well defined.

* More efficiency

The time and resources can be well determined in order to enable

developers to manage the project more efficiency.

The Waterfall Model is shown as below:

l Requirements
System analysis

System design

System development

System implementation

Maintenance

Figure 3.1: The Waterfall Model
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The waterfall model encompasses the following activities:

1% Requirements

This first stage is the requirements gathering stage to determine requirements of
the system. To developing the visualization system, the requirements gathered would
include the interaction between subsystem, functionality, behavior, performance,
interface, and constraints of the system. The requirements including functional and non-
functional are documented and reviewed. Besides that, software and hardware

requirements during the development stage are also have to identify.

2. System Analysis

In the second phase of the system development life cycle, the system analysis is
concerned with identifying problems, opportunity, and objectives. The real problem is
determined and the best solution is decided. Opportunities can be conceived of as the
observation of the problem, and improvement can be defined as changes that will result

in increment yet worthwhile benefits. Then the specification and the constraints of the

project can be determined to define information requirement.

3. System design

The systems design establishes overall visualization system architecture, For this
project, system design focuses on distinct attributes of the modules in visualization
program. The main page appearance of the visualization subsystem was designed in this
stage. Thus, the flow chart of the system, interface representation, and technical of

visualize are also required in this stage. In addition, the project system design also
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includes transforming the requirements into a representation that can be assessed for

quality before the code generation (implementation stage) begins,

4, Implementation and unit testing

During this stage, set of programs or program units section in visualization
modules like User Section, Visualization section and Executive Information System will
be create in the system based on the project system design. After code has been

generated, unit testing is performed to verify that each unit meets its specification.

Integration and system testing

This stage tests the complete of visualization of bioheat system. All the program
units tested as a complete system to verify that the software requirements have been met.

The system is delivered to the user after the testing process.

6. Operation and maintenance

Maintenance takes place after the system is put into practical use. Maintenance
involves correcting errors missed in earlier stages of the life cycle, improving the system
implementation, adding performance or functional enhancements or making changes due

to accommodate changes in the software external environment for overall this system.
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3.2 Methodology of calculating equation of bioheat process.

In another approach using the pdetool GUI, similar mathematical formulation
and boundary conditions are applied. This approach is perhaps easier to grasp and can be
taught as part of the heat transfer. However, care should be taken to balance the skill of
solving parabolic PDE numerically with that of using this ‘black-box’.

The estimation of temperature profiles inside a human body is performed by
developing a numerical programming using MATLAB and applying its PDE Toolbox
(pdetool) Graphical User Interface (GUI). There are 4 types of PDEs which is
hyperbolic, parabolic, elliptic and eigenmodes. From the pennes’ equation, the equation
of parabolic is likely the same. I choose to use the parabolic equation and heat transfer to
solve this equation. The Parabolic and heat transfer PDE:

Rho*C*T’ — div (k*grad (T)) = Q+h*(Text-T)

Cquation: o C*T divik"grad(T )}Q +h " (Toxt.T). Telompersture

Typo of PDE Lootticiont Vahi Descrption
tho 10 Denmty

€ Eliplic
|~ 10 > Heat copaciy

& Poaboke

e k I 10 TR Coall. of heat conduction
0 [l 0 Eomean 1 el Hoat saurce

~ %
h ¥ PR Conv bt hansder coell
Tont 00 ety 1 sdenrral bovng e st

o ] Cares I

Figure 3.2: Options in the equation solver,
In this work, the thermal parameters which is coefficient of heat conductivity £;

thermal capacity C, density 7ho, heat source Q, temperature T, external temperature Text
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and conductivity heat transfer coefficient h. The resulting parabolic PDE of the
temperature 7" with respect to this parameter, it will display the visualization in many
ways that you want after insert the values to the equation.

There are several general step to any PDE problem, and there are a few more to

solving them numerically. These are:

o defining the domain of the problem in space (i.e. the geometry- draw

mode)
o defining the time-dependence of the problem
o defining the initial and/or boundary conditions
« setting up the proper PDE for solution
« choosing the "coefficients" or physical properties of the system

o defining the "mesh" or set of sub-domains on which to numerically solve
g

the PDE
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CHAPTER 4: SYSTEM ANALYSIS

As is progress from the literature research and review stage, the next phase is to
perform a through and detailed analysis of the system development. Emphasis will be on
the functional and non-functional requirements of the system development needs. Thus 1
can say that system analysis is a stage of gathering, analyzing, and finalizing or

determine the problem scope and the objective of goals, which the system will have to

achieve.

4.1  Technique for requirement elicitation

Capturing requirement of 4 system or in a more formal note-eliciting requirement
seems to be a very straightforward process, However, it does face several barriers, which
complicates the whole process. The problems are many and one of it could be that the
users do not know what they want, or that the analyst thinks they understand user

problems better than user do. Nevertheless, there are techniques that have proved

effective in addressing these problems,

Information from internet source

This is main source, it is easy and quick to get information about bio-heat

process. The way to search the reference of the bioheat process is using search engine

like Yahoo, Google, and AltaVista.

38



Printed material

The printed material that was used is mainly Journal and books from the Main
Library of Malaya University. Especially the textbooks and guide books a programming
language that was from previous years of studying in the field Artificial Intelligent and
about heat conduction and thermal process. However, information knowledge was also
gained from journals and conference paper.

The reports on the previous projects also help a lot especially in the structure of

the documentation. It helps a smoother flow to the documentation by giving ideas on the

structure and contains.
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4.2 Analysis Procedures

An analysis procedure is important in order to identify the various requirement
and objectives that need to be met by the user. The outcome of the analysis will serve as
guideline for the developer during the design on what and how the system has to

function in order to fulfill the user require. Listed below are the procedures for system

analysis:
i) Problem Identification
i) Evaluation And Synthesis
iii)  Modeling

iv) System Requirements And Specification

4.2.1 Problem Identification

Essentially the first phase in the system analysis procedure, the problem
identification stage is being carried out in order to recognize and identify the objective
of the system and the goals that the system need to meet in order to satisfy the user
needs. In visualization of bioheat process module the problem identification is that the
system has to perform the visualization temperature of human body in many ways. The
main goal that needs to be met by the system is to be able to function in a real time

manner as well as to provide the usera reliable, user friendly and efficient functionality,
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4.2.2  Evaluation and Synthesis

In this stage, analyzing of problems has to be done by dividing the problem
scope into smaller parts so that the problem can be tackle one by one. By doing this, we
can have a better view and understanding on the problem scope and eventually easier to

solve.

The following are problems that needed to be considered for system requirement:

1) Consideration of programming language that will suite the development of
the system.
ii) Consideration of how to manage the processing and data flow of the system.

ii)  Consideration on direct to solve the equation of bio-heat process.

iv)  Consideration of combination of many visualization.

4.2.3 Modeling

By using a graphical representation on the data flow process, we can better

understand how the system actually works. A graphical model such as flow chart can be

present the flow of the system is built,
The analysis here has the following main objectives:
e To solve for the bioheat equation of human body temperature
e To determine the distribution of minimum temperature and maximum temperature
The basis for modeling is Pennes’ bio-heat-transfer equation, which is equipped
with a temperature-dependent blood perfusion. The purpose of Pennes’ study was to
evaluate the applicability of heat flow theory to the forearm in basic terms of the local

rate of tissues heat production and volume flow of blood. An important feature of
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Pennes’ approach is that his microscopic thermal energy balance for perfuse tissues is
linear, which means that the equation is amenable to analysis by various methods
commonly used to solve the heat-conduction equations. For example, I used the Pennes’
equation to analyze and developed a few part in human body thermal model. The
equation proposed by Pennes is now generally known either as the bioheat equation or

as the Pennes equation.

The equation is:

Table 4.1 The equation.

Equation

Convention Description

pdetool Rho*C*T’— div (k*grad (T))=Q +h * (Text -T)
Where:

k coefficient of heat conductivity

C thermal capacity

rho  density

0 heat source

T temperature

Text external temperature

h conductivity heat transfer coefficient
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Mathematical equation

pcOT/Ot=div(k gradT)-"° W(T-Th )+ Qe

where:

P~ density of tissue

c specific heat of tissue

t time

T tissue temperature

K thermal conductivity of tissues
Co specific heat of blood

Ty blood temperature

W% mass flow rate of blood per unit
volume of tissue
Qe  deposited by an electric field E in tissue

with electric conductivity

Limitations of Pennes' Model

The limitations of this model arise from the erroneous view of the heat transfer
process and its anatomical location. The thermal equilibration length is defined as the
length at which the difference between the blood and tissue temperature decreases to 1/e
of the initial value. The limitation of this model is that given the detail required, the

model is not easy to implement. Also, the perfusion conductivity term is difficult to

evaluate.
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4.2.4 System Requirement and Specification

The requirement is a characteristic or descriptions that play in system
development to complete a system in execution as suggested. It is not only explaining a
flow of input and output information about the system but also explaining the restriction
too in system execution.

To get exact requirement, each process need a repetition and should be involve a
feedback from end-user and system developer. An exact requirement is important to
ensure that the system executed normally. For the system requirement specification there
have two type of requirement.

There are 2 types of requirements, which are;
i) Functional requirements

i) Non-Functional requirements

4.2.4.1 Functional Requirement

A functional requirement refers to the interaction between the system and the
working environment the system resides in. It also describes how a system should
behave and perform their task given a set of input or stimuli. Stated below are the

components in functional requirement analysis:

Visualization module
This section refers to the visualization modules of this system. We can say that
this section has the foremost of importance among the functionality requirements for it

processes the user request and therefore generate the intended output, The system
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processing has two modules, which also represents each visualization task category as

listed below:

Perform mathematical computations

The system must able to perform all the mathematical calculations
required by the partial differences equations (PDE). The system must be
able to generate accurate results for every calculation.

Use interface Module

Describes the responsible on how the communication between the user

with the system in getting information or input from the user for further

processing. We can distinguish the main criteria which emerge in this
section which are the:

a) Display Module - front end design or the user interface which
serves as the direct interaction phase between
the user and the system.

b) Result Page — page include a listing of the processing results

which is performed upon the user request

4.2.4.2 Non-Functional Requirements

Other important criteria to ensure the user satisfied must give an attention. It is

not only about the function that is executed by the system, but its need a non-function

requirement involved. Non-Functional requirement can be described as constraint where

the system must operate to a certain degree of standard of operation. These constraints

usually narrow the selection of development tools such as programming language,
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platform and others. Listed below are the non-functional requirements of the system:

i)

iii)

Reliability

Reliability refers the extent of the system performance that are expected or

desired by the user, which required criteria such as precision and accuracy.

Reliability will convince the user on the capability in performing to their

expectation as well as providing error-handling capability.

Maintainability

Maintainability refers to the degree which the system can perform its

function or adapt to a possibly changing of operation environment. A good

maintainability system will be easy to modify and test in future upgrading of

the system or correcting the errors or moving the system to other computer

system.

Efficiency and correctness

The system can do what the user want when it is needed although it has been

used all the time and it can use within any problem.

User Friendliness

Designing of a graphical user interface will eventually enhance user

friendliness as well as easier for the user to understand and use the system.

Good consideration of user interface design is that the interface must fulfill

the following criteria:

a) Consistent or standard — which mean every interface of different module
shall look similar in order not to confuse the user.

b) High Degree Of Understandability — Enable easier use of the system,
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4.3 Hardware and Software Requirements

Hardware

Hardware requirement refer to the hardware support needed in order to run the system
smoothly.

Control Processing Unit Pentium 4 1.8 GHz

Memory Space HDD 20.0 GHz

Random Access Memory 128 DDRAM

Other requirement Mouse, Keyboard, CD-ROM, VGA, and sound system
Software

Software Requirement refers to the application or software tools needed in order to
develop and run the system at the server side.

Operating System Windows XP or Windows 2000

Programming Language Matlab 6.5

44 Summary

This chapter mainly deals with the requirement of the system. At the beginning it
was explained what technique were used to solicit the system requirement. After that
analysis about the equation used to solve this problem. Lists of functional and non-
functional requirement were specified. Besides the minimum hardware and software

requirement for the system was also mentioned.
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CHAPTER 5: SYSTEM DESIGN

5.1 Introduction

System design is a phase of the waterfall that entire requirement are translated
into system characteristic. The requirements for the system are regarding to the analysis

that had been discussed in the previous chapter. System design includes the following

issues:

¢ Main menu module

* Visualization module
5.2 System Functionality Design

3.2.1 System structure charts

There are 2 categories of users. This is a system structure chart for the expert
user (doctor). The flow of main program for expert user is:

1. Start

2. Call matlab function such as:
* defining the domain of the problem in space (i.e. the geometry)
* defining the time-dependence of the problem
* defining the initial and/or boundary conditions

« setting up the proper PDE for solution
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e choosing the "coefficients" or physical properties of the system defining
the "mesh" or set of sub-domains on which to numerically solve the PDE.,

3. Display the result in many ways of visualizations,
4. If the user wants to use the new values, user will return to set the pde again,

If not the system will stop.

v

/ Inputvalue in /
/ parameter //
I

Call M atlab function

e ———————————————————————————————

!

|

e, S
/ Display %
7z graphical result 7
4 according to the /
user //
Z Ly -
S
Yes = et T )
-~ Return PDE T
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Figure 5.1: The flow diagrams of main program visualization for expert user

(doctor).
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The flow of main program for non-expert user is:

1. Start

2. Click the button

3. The result will display

4. If the user want to see the other visualization then continue with click the

button. If not, stop.

I, T RN AR —emasad. 4.

Click the button

J

|

Display /
graphical result /

Figure 5.2: The flow diagrams of main program visualization for non-expert

user (patient),
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The PDE solutions have six steps and corresponding PDE Toolbox usage modes are:

13

2.

Identify the equation

Specify the domain (geometry definition)

Domains are constructed by the addition and subtraction of primitive domains
such as rectangles, polygons, and ellipses. To form the desired domain, type in a
formula in the set formula box (above the displayed region) to combine the
primitives by addition or subtraction.

Specification of boundary conditions (boundary condition mode).

Selections of PDE coefficients that define the problem (PDE mode). Select PDE
specification and then choose a problem type (the default is Elliptic).

Specify initial mesh (mesh mode).

Solution of the PDE (solve mode) and output will display based on users.
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Identify the equation
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Start the Matlab PDE toolbox

|
Y

Specify the domain

I

Specify boundary conditions

.

Specify the PDE
Specify initial mesh and desired Check use}\\ A Ve }Y"":’l'lc with
mesh refinement expert cig dt, contour
N & and arrow
No
Visualize with color N
Solve PDE and
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Figure 5.3: The flow diagrams of program how to solve the equation
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5.2.2 Modeling

Modeling is the process of creating the creatures and furnishing of your scene.
The goal of modeling is to create convincing. This system is accurately modeled with
Pennes’ equations and modeled with the bioheat transfer equation. The bioheat equation

can be solved by pde tool in matlab function of the bioheat equation.

3.2.3 Visualizing of temperature
The temperature of human body can be visualized by colour, arrow, contour,

height 3-D, and animation.

» The colours (shown as different shadings in the printed diagram) represent the
high and low temperature. The scalar colour bar that is used for showing
temperature values.

» Animation is effective when there is a need to enhance the emotional impact of
the message and break up the intensity of too much textual information. This is
particularly useful in this application because the target users are visualizing the
temperature human body. In this dissertation, animation is proposed to be use

and create a cognitive tool to visualize the concepts of fractions,

5.2.4 Interpretation
Interpretation is a step in which temperature are identified and labeled with

meaningful terms such as “whole matter”, This process can be performed interactively.
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5.3  Graphical user interface (GUI)

Using the interactive Guide Editor in Matlab developed the GUI. Developing an
interface in Matlab proved to be challenge to the author. The GUI development tools
were found to be rather unstable, causing constant crashes, and non-user friendly.
However, through the implementation of a GUI, the visualization system has been made
user-friendly. The user non-expert can view the visualization through just the clicks of
buttons and the visualization will be view,

The basic emphases on GUI are:
e Simple but attractive and easy to understand
e [Ease of browsing
¢ Guidance provided. Name of buttons are clearly stated and understood.

e User friendly. Users will not face any problem when using the system.
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A prototype of the system is prepare in figure 5.1 as below:

Scientific Visualization

Human Body Temperature
(Bioheat Process)

Home

View Visualization

System Options Command Window
? Help

Exit

Figure 5.4 Interface design of scientific visualization of bioheat process
The prototype for this GUI will create in MATLAB using GUIDE, the GUI

Development Environment.

5.4  Statement of Expected Outcome

This project is a system, which can visualize the temperature of human body and
provide the information of the temperature. The expected outcomes of this project are:
e A system that will emphasis on user point of view,
e Interface that include multimedia application.

e Easy for enhancement and maintenance
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3.5  Summary

System design provides a bridge between system analysis and system
implementation. In this chapter, the functionalities of the system were outlined and ways
of designing the system in order to be able to perform those functionalities were
discussed.

Once the systems functions and process have been designed, it will served as a
guideline to aid in other design issues, such as the user interface design. The ends of the
section present the possible user interface design for the system

Computer programming and modeling using MATLAB elevate the people
interests and understanding of heat transfer. This approach enables the people to better
visualize complex processes of multidimensional transient heat transfer. Once they
appreciate the graphical solutions of the pdetool GUI, they can then develop computer

programs based on appropriate numerical techniques.
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CHAPTER 6: SYSTEM IMPLEMENTATION

6.1 Introduction

After the system-designing phase on how the system should be functioning, the
next process will involve the implementation phase. The implementation phase is an
important element especially when it involves a project developed where integration of
system is needed between sub systems.

The design phase earlier in the system life is directed towards a final objective,
which is to translate the concept of the system into a software representation that is
understood by the computer. The coding process involves transforming of the design
into a programming language.

The effort spent in this phase will actually determines the success of the system
and ease the processes of modification, debugging, testing, verification, system
integration and for future enhancement.

In this chapter, details regarding the steps of the implementation on the Scientific

Visualization of Bioheat Process system will be discussed.
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6.2  Development Environment

6.2.1 Hardware Used In Developing The System

The following hardware specifications have been used to develop this system:

1. Pentium (IV) 1.80 GHz processor

ii. 128MB DD RAM

1, 20 GB Hard Disk

iv. Other standard computer peripherals

6.2.2  Software Used In Developing The System

The software tools used for system development are vital to the successful

implementation of Scientific Visualization of Bioheat Process System. The software

specifications used in the development of this project are illustrated in Table 5.1,

Table 6.1 Software Configurations.

Software

Usage

Description

Microsoft Windows 2000 or XP

System Requirement

Operating System

MATLAB 6.5

System Requirement

Application Developer

Adobe Photoshop 6.0

System Development

Graphics Editor
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6.2.3 Operating System

As mentioned the platform or operating chosen for the development of Scientific
Visualization of Bioheat Process System as the stand alone system is the Microsoft
Windows XP or Windows 2000. The rationality behind the choosing of Windows XP or
2000 as the operating system is solely based on the performance as well as the reliability
of the operating system architecture. These features eventually make the Windows XP or

2000 as the ideal operating system for most development of systems.

6.2.4 Programming Language Chosen

The language chosen for the development of Scientific Visualization of Bioheat
Process System is MATLAB 6.5 which functions as the visualization system. The
reason for me to choose this language is because of the simple structure and syntax of
MATLAB 6.5 language makes it easier for me to identify and debug the system,

One of the important advantages of using MATLAB in visualization applications
is the availability of built-in functions called toolboxes. In this work, the pdetool GUI is
applied in solving transient heat transfer problem.

The pdetool GUI can be started by typing pdetool at MATLAB’s command prompt as
follows:

>>pdetool

To GUI can be start by typing guide at MATLARB’s command prompt as follows:

>>guide
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6.2.5 System Coding

Most of the time, this system is designed using MATLAB Programming,

Table 6.2 List of MATLAB function

MATLAB Function Sub Function Description

function varargout | a. function Main_OpeningFen | The main page of this system

b. function btnHome Callback The Home button
c. function btnHelp Callback The Help button
d. function The Close button

close_pushbutton_Callback

e. function btnView Callback The View Visualization
button
f.function submit_Callback Define the user
g. function reset Callback To reset the user
function pdemodel | a. pderect Geometry description -
rectangle
b. pdeellip T iy (}'Ei;metry description -
ellipse
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pdecirc

Geometry description - circle

. pdepoly Geometry description -
polygon
. pdesetbd Set boundary conditions
pdetool(‘initmesh') Mesh generation
. pdeseteq Set PDE coefficients
. pdetool('solve") Solve PDE
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6.3  Summary

To sum up chapter 6, we can say that the implementation of Scientific
Visualization of Bioheat Process System focus on various aspects which governs the
functionality of the system to fulfil the functional and non functional requirements of the
system and also describes the function in MATLAB. Hence the choosing of
development platform which ranges from the operating system till the programming

platform chosen has to be up most suitable to the requirement of the system.
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CHAPTER 7: SYSTEM TESTING

71 Introduction

System testing is essential to ensure the system performs according to its
specifications and in line with users’ requirements and expectations, Testing is done
throughout system development, not just at the end.

Testing is performed to detect the existence of faults and then try to correct it.
Therefore, a systematically test procedure is need to make sure the system is tested
thoroughly and completely. There are several types of testing: unit testing, module

testing, integration testing, system testing and acceptance testing,
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7.2 The testing process

7.2.1  Unit Testing

Individual components are tested to ensure that stand-alone program fixes the
bug without side effects. After a new component is developed, it is tested independently,
without other system components. This is to assure that the component is able to work
accurately and persistently. All function on each button is examine to ensure it perform
the entitle output such as link to the right page, call the right function to execute, display
the correct message according to the error and eliminates all the syntax faults occurred.

For example, function submit_Callback (hObject, eventdata, handles), this
function has to find the right page according to the user.

As the expert user, is generating visualization based on the value, different
variables have different value so that it has to test to verify its robustness. What I have
found out that is at first I used the value, this will raise an error when the visualization
has viewed. The result not precisely when this problem happened. So I have to do a table
of value of variables.

In this aspect, program coding is reviewed by examining it line by line in order
to reduce semantic errors during implementation of the program. The coding is
compared to the original design of the program flow. As the result, the correctness of
coding can be identified. When the logic and flow of the program were identified, the
code is commented and it can be traced in the future. The code is also examined and

debugged in order to identify any fault coding.
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Table 7.1 Table of Value

Material | Conductivity | Density | Specific | Temperature | Time | Qm
Wm™ K™ ! (Kg heat (kJ (W/m3)
(1)) m>)y* I kgT! | (T '
107 Kenait) ! (t)
() (Cp)
Skin 0.001 1.085 3.6 0 1- 0
3.68 100
3.8 sec

Bio-heat equation

p ¢ T’- div( k grad(T)) = Q+h(Text-T)

Parameter

P density of tissue

c specific heat of tissue
t time

T tissue temperature

K thermal conductivity of tissue

Q body heating coefficient
Text external temperature
h conv. Heat transfer coeffient

The Scientific Visualization system is a system that contains a few modules that
perform specific function and in each of the modules created, it contains some sub-
functions or action command. Therefore, unit testing is conducted on each of the sub-
function and finally to the module itself,

In unit testing, the following aspects are considered:
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» Interface — tested to ensure that information properly flows into and out
of the program unit under test. I have test all interface in the Scientific
Visualization system to make sure that data can be passed from the
previous page to the next page.

» Boundary conditions — tested to ensure that the module operates properly

at boundaries of geometry.

In the development of Scientific Visualization of Bioheat Process System, unit
testing was done after the development of each module and not the end of the
development of the whole system. The object and MATLAB codes were thoroughly
checked and tested to ensure that the functions and data were implemented properly as

indicated in the design.
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7.2.2  Module testing

Module testing will focused on each sub module in Scientific Visualization of
Bioheat Process System. There are totally 11 sub modules, so testing was carried out to
ensure that the codes under the sub module work accordingly when all units of code are
integrated.

Each of the sub modules is tested with the specific functions that perform to see
whether they really output the results or fulfill the design requirements. For example, the
draw geometry sub modules are tested whether it can really generate the correct
geometry. If the error is occurred from a particular sub module, the part of the sub
module could be identified and unit testing is used to identify the errors. After that, all

sub modules group into module to perform the testing.

Table 7.2 Testing Description for module in Scientific Visualization System

Module Sub Module Testing Description
Main Menu Login 1. Displaying correct page according
to the user.
Help 1. Search using for options available
Exit 1. Correctly show the page to close the
system.
Command Window i'.*[_)ispluying ‘i;i.{:?ssydgéu reference for
the user,
e e |
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Visualization

(For Expert User)

Geometry

. Draw the geometry in human body

in 2D grid.

. The test can draw successfully with

the formula.

Boundary Mode

Specify boundary condition for this

geometry (group of segment)

Mesh Mode

The mesh can be further refined to

increase the computation accuracy’.

PDE Mode

. All the fields are check to ensure

that are fill in with correct data in

variables.

Solve PDE

. Matlab  will interpolate  the

temperature distribution solve the

equation,

. Set the initial condition

Various Visualization

Display visualization 2D
temperature  profiles in colour,

contour, ete,
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Visualization
(For  Non-Expert

User)

System Overview

Show the hands geometry as apart

of human body and the layers of the

hands.

Mesh

Show the mesh to solve the problem

View Visualization
(View 1, View 2and

View 3)

Show  the visualization and
comparison between temperatures

in hands as a part of human body.

Logout

To logout the user
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7.2.3  Integration testing

When I have satisfied that individual component are working correctly and meet
out objectives, I combine them into a working system. This integration is planned and
coordinated so that when a failure occurs, I have some idea of what caused it. In
addition, the order in which components are tested affects our choice of test cases and
tools. Some components may be in the coding phase, other may be in the unit-testing
phase, and still other collections of components may be tested together.

The purpose of integration testing is to test the integration of overall
performance of the system. The criteria taken in accounts are:

> Interface integrity — interfaces are tested as each modules to check if there is

any lost of data across interfaces.

% Functional validity — tests designed to uncover functional errors are
conducted.
% Information content — tests designed to uncover errors associated with data

structures are conducted.
% Performance — tests designed to verify performance bounds established

during software design are conducted.

The system tests performed:
» Compatibility Testing
This test was performed, and the interface functions according to the
requirements. The accuracy of data retrieval was high, and the speed of

data retrieval was acceptable.
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7.2.4  System testing

As mentioned earlier above, the Scientific Visualization of Bioheat Process
System actually consists of 2 main functionality options. The first is on the modules
which reflect the 4 menu in the Scientific Visualization of Bioheat Process System. The
other part of the Scientific Visualization of Bioheat Process System is on the
visualization functionality which consist the main functionality of visualization in body
temperature. This reporting functionality consists of the geometry the body, boundary
mode, mesh mode, pde mode and solves pde. The focus of the testing phase will focus
on the integration of both the functionality. This is to ensure that both functionality as
well as all the modules is able to work as an integrated unit as well as being able to

perform their particular task correctly.

4 Main Menu
Modules
Integrate as System
ey FallUniti »| Testing
10
Visualization
Modules

Figure 7.1 System Testing
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7.2.5 Acceptance testing

Acceptance testing, or sometimes called as alpha testing is the final stage of

testing whereby the system is tested before being accepted by the user for operational

use. Acceptance testing reveals errors and omissions in the system requirements

definition because the acceptance testing involves testing from the user. During the

acceptance testing, the functionality of the system is demonstrated to the user and the

users may experience the systems handle on.

Unit Testing

3

Module Testing

7

Integration
Testing

Component
Testing

System Testing

A

Acceptance Testing

[ntegration
Testing

User
Testing

Figure 7.2: The testing stages
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72 Results and discussion

Temperature predictions are commonly based on Pennes' bio-heat transfer

equation (1) which is the conduction heat equation.

p e T- div( k grad(T)) = Q+h(Text-T) (1)

The left-hand side terms of equation (1) represent respectively, conduction
through tissue with thermal conductivity kt and the rate of energy increase of the tissue
volume. The right-hand side term describes heat convection associated with blood flow,
and metabolic heating.

The discussion will focus on graphical outputs of pdetool GUI. The application of
pdetool GUI is one of the easier ways to solve the equation and visualization. In this case,
PDE can be implicitly solved by plugging in a few parameters in the GUI as explained in
the methodology section. A set of pdetool GUI outputs is illustrated in Figure 7.3. It is
Worth to note that the graphical results of the pdetool GUI may vary depending on the

mesh size.

The finer mesh, the smoother the temperature profiles will be but the longer it will
take for MATLAB to obtain the solution. Figure 7.3 shows the resultant temperature
Profiles of the view from 1 sec to 100 sec duration. Initially (1 sec), the system is at an
initia] temperature of 37°C, which is the normal temperature of human body. After 25
Seconds, the system temperature starts to increase heating and shows heating profiles.

These temperature profiles vary according to the preseribed boundary condition
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Specifications, of which temperatures are respectively set at 50°C, 100°C and 150°C. At
the end of 100 sec simulation, almost all sectors of the hand are heated to temperature
greater than 20 °C. The usefulness of pdetool GUI in the enhancement of heat transfer is
indeed obvious.

Various parameters and factors may change while maintaining some other values.
Geometry considers of confining boundaries is an important influencing factor in heat
transfer. Different thickness very importance factor in heat transfer process. When

thickness increases the burn is also increase quickly.
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B Visualization at different time

View of temperature distribution (color bar in Celoius) at various time intervals

Time:1 Boundary: 150 Specific Heat:3.68 Time:26.75 Bouncary:150 Specific Heat:= 68
1 1
05 05
0 0
Ml
05 05 Al ANATAVTAY),
5 -1
1.2 2

waARArA,
BT\

»
1

:5

\ 1

A A !
NI

'Yy UR S . "\ YA J
WOAAKLATX N/ Y LATEN | ATV

Figure 7.3 The resulting
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74  Summary

All described tests were carried out as planned. All the tests were being applied
on the system to check if the system errors free. The tests were being applied to the
system by following the sequence of the description of the testing approaches in this
chapter. The results of the tests were quite effective because errors can be uncovered. If
an error was found, straight away modification will be done. As a conclusion, all the
testing approaches were being applied to the system and successfully check if the system

is error free.
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CHAPTER 8: SYSTEM EVALUATION

8.1 Introduction

The final chapter for the thesis report of the Scientific Visualization of Bioheat
Process module focuses on the system evaluation of the system as a functional
visualization system. The evaluation of the system will eventually focus on the problems
encountered during the development of the system, evaluation of the system by end user,

system strength and limitations as well as its proposed enhancements.
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8.2

System strengths

Visualization module is easy to use

This system is ability to process on going data as well as performing geometry
and visualization. The main strength of the Scientific Visualization of Bioheat
Process System is the ability to perform the geometry in human body and its
behaviors in visualization. Geometry representation of model elements is easy to

understand.

User Friendly User Interface

Has a simple interface design is the focus on one point which is simplicity. Since
it is intended for the use of medical professional of an organization, it may seem
ridiculous to ‘decorate’ the system as of the ‘normal people’ oriented system.
The simple design is specially designed to suite a more professional look with a
more simple background. The reason of simplicity is because to enable the user
to make ease of use. This means that a simple interface will give the user more
and faster understanding in using the system and they are able to use the system
to the fullest potential. It also tries not to confuse the user with all different kind

of decorations being ‘crafted’ on the interface.
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8.3

System constraints

Lack of Functional Modules

Although being able to perform the major and important task of the geometry
and the visualization of temperature, this system only focus on one part in human
body which is hands. Well this minor functionality may provide the ideas for the

future enhancements of this system.

. 2D Geometry

At the present time, the PDE Toolbox solves only those 2-dimensional problems
the extension to true 3-dimensional problem solving would require significant
redesign of the toolbox. There is a product called FEMLAB that will solve true

3D problems but the problems, the software is difficult to get.

Security in Password

Because the Matlab not have the function to visible the login name of expert user
and non-expert user so, this system is not secure. To solve this problem I
changed the background at login name into black so that, other people cannot see

the password.
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8.4

Future enhancement

. Increase number of runs example

It is would help to identify the important factors affecting temperature in human

body.

. More attractive interface

Although the concept of the interface of Scientific Visualization of Bioheat
Process System is on simplicity but there may be future enhancements whereby

the creative minds of others may give some life into the interface.

. Develop using other software

This system did not include 3D geometry which can build using Java, FEMLAB,
PRO-E and many more. This is partially due to lack of time, these software

useful for future visualization especially in 3D geometry.
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8.5

Problem encountered

Defining The System Scope Due To The Wide Area Of Study

Most of the problems encountered under this category eventually occurred
during the literature review period. Through research has to be conducted in
order to understand how a normal Scientific Visualization of Bioheat Process
System works. However the most challenging thought came from understanding
how the visualization and the solving the partial differential equation flow. Since
the principles of visualization disciplines seemed quite new and raw in my
knowledge and understanding, therefore I find it quite hard to understand the
visualization and their problem solving flows. However after further explanation
by my supervisor, I eventually got a better understanding and able to relate them

with the actual data flow in a computer system design and architecture.

Requirement Changes

It is very difficult to develop and implement the system when the requirement
changes very frequently. Sometimes it is easy to change the requirement,
however, the coding need to be changed a lot in order to follow the new

requirement.
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3. No End User Evaluation
No end user tested the Scientific Visualization of Bioheat Process System
because there is lack of time. Only Prof. Madya Dr. Roziati, my supervisor, tests
on it and give some comments. So, I did not really know what the end user

comment on my system is.

4. Integration Problems
There are several problems when the integration process. When integrating
modules in the Scientific Visualization of Bioheat Process System, I find that
there is problem in passing the value from one module to the other module

because each module has a different function.
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8.6  Knowledge Gained

Well for the past 4 months or so, things have been very interesting because 1
have been able to gain invaluable experience and knowledge while doing the Scientific
Visualization of Bioheat Process System project. The knowledge and experience varies
from programming, system analysis and design and other system development
principles. I was able to apply the knowledge I learnt throughout my years in University

Of Malaya into this project mainly on programming and system design principles.

Besides that, the knowledge gained from this project is the awareness of user’s
needs. It was found that users need a user-friendly environment, clear instructions and
guidance. There are improvements in skills of finding information, classifying fields,
solving problems and independently plan and accomplish the project on schedule

without much supervision.

But the most important experience I have gained is the ability to work
independently by myself, coordinating system design as well as integrating my final
system. At the same time, the ability and experience to develop system is deemed very
beneficial to me and I believe that these knowledge and experience I acquired during my
time doing this project will sure prove its worth in the future especially when I approach

the working world in the future.
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8.7 Review on Goal

The project had successfully created a system that supported the information
need for the organization to complete their functionality. Finally, it could be concluded

that the objectives to establish the system had been achieved.

8.8 Summary

The Scientific Visualization of Bioheat Process System as a visualization model
is fast, accurate and an excellent baseline visualizing the temperature of human body. It
is very important for user to know well in their temperature. However, there are also
some limitations that the system cannot be done. It needs to be enhanced in order to
transform it to a more advance system. Despite the limitation, the project had reasonably
achieved all its objectives.

This system is actually given the opportunity to integrate their theoretical
knowledge in heat transfer numerical method and computing skills gained a priori. The
system is modeled by applying heat balance across the hands human body. The resulting
parabolic partial differential equation (PDE) is solved using finite difference method and
PDE Toolbox (pdetool).

The advantages of visualizing the temperature in bio-heat process is that user can
obtain view and visual effects. For example, in the future it can be helpful to doctor to
detect the patient’s symptoms because the system can give them views easy 1o see their

temperature.
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APPENDIX

Coding Used To Build The System

1.

To pup up window while running in Matlab

function varargout = Main(varargin)

gui_Singleton = 1;
gui_State = struct('gui_Name', mfilename, ...
'gui_Singleton', gui_Singleton, ...
‘gui_OpeningFcen', @Main_OpeningFen, ...
'gui_OutputFen', @Main_OutputFen, ...
'gui_LayoutFen', [], ...
'gui_Callback', []);
if nargin & isstr(varargin{1})
gui_State.gui_Callback = str2func(varargin{1});
end
if nargout
[varargout{1:nargout}] = gui_mainfcn(gui_State, varargin{:});
else
gui_mainfcn(gui_State, varargin{:});

end

To check the user while login,

function submit_Callback(hObject, eventdata, handles)

user_name = get(handles.login,'String");



3.

4.

if strcmp(user_name,'expert’)
set(handles.Iogin,‘BackgroundCoIor','k');
expert;
set(handles.login,'String',");
elseif strcmp(user_name,'user’)
set(handles.Iogin,'BackgroundColor‘,‘k');
nonExpert;
set(handles.login,'String',");
elseif ~strcmp(user_name,'expert’) & ~strcmp(user_name,'user’)
warndlg('Incorrect Login Name ! Please enter a correct login name!','!! Error !!)
set(handles.login,'BackgroundColor''k’);

end

To reset the login.

function reset_Callback(hObject, eventdata, handles)

set(handles.login,'BackgroundColor','k’);

set(handles.login, 'String’, ")

To exit the system

function close_pushbutton_Callback(hObject, eventdata, handles)

pos_size = get(handles.FigureVisual,'Position'),
user_response = modaldig(‘Title','Confirm Close')
switch user_response
case {'No'}
%take no action

case {'Yes'}



%prepare to close

delete (handles.FigureVisual)

end

5. To use the visualization (pdetool)

function [u3,u2,ux,uy]=rozy(asd timerange,a,b,handles)

[pde_fig,ax]=pdeinit;
pdetool(‘appl_cb',9);
pdetool(‘snapon','on');
set(ax,'DataAspectRatio’,[1 1 1]);
set(ax,'PlotBoxAspectRatio’,[1.5 1 1]);
set(ax,'XLim',[-1.5 1.5]);
set(ax,'YLim',[-1 1]);
set(ax,'XTick',[ -1.5,...

St

-0.5,...

1)

0.5,...

1l

1.5,...
)R
set(ax,"YTick' [ -1,...

-0.5,...

O

05,..

[

)}



pdetool(‘gridon’,'on’);

% Geometry description:
pderect([-0.65000000000000013 1.45 0.29999999999999993 -

0.49999999999999989],'R1');

pdeellip(-0.84999999999999998,0,0.59999999999999998, 0.59999999999999998. ...

0,'C2'),

pdecirc(-0.84000000000000008,0,0.24990000000000004,'C1');

pdeellip(-
0.13000000000000017,0.49999999999999994,0.20000000000000001,0.2000000000
000000t1,...

0,'C3"),

pdepoly([ -0.7665063509461093, ...

-0.56650635094611002, ...

-0.13349364905389011, ...

-0.33349364905388934, ...

T

[0.20179491924311149, ...

0.54820508075688745, ...

0.29820508075688845, ...

-0.048205080756887508, ..

Jions

'R2Y);

pderect([-0.24999999999999967 -0.05999999999999972 0.5
0.29999999999999993),'R4');

pdepoly([ -1.3572245179455604, ...

-1.0295637002299638, ..

-0.74277548205444022, .,



-1.070436299770037,...
Jiees
[ 0.44007272380203827,...
0.66950329834245714,...
0.25992727619796152,...
0.030496701657542646, ...
)

'R3);
pdepoly([ 0.049999999999999933, ..
1.45,...

1.45,...
e
[ 0.29999999999999993, ...
0.39999999999999991,...
0.29999999999999993, ...
I

P1),
pdepoly([ -0.65000000000000002,...
1.45,...

1.45.,...
Jie
[-0.5,...

-0.59999999999999998, ...

0.5,...
J

P2)
set(findobj(get(pde_fig,'Children’),'Tag''PDEEval),'String''(R1+C2+R2+R4)-
(C1+R3+C3)+(P1+P2))



% Boundary conditions:

pdetool('changemode',0)

pdetool('removeb',[37 8 9 1213 14 15 16 18 22 24 25 26 27 28 29 30 38 39 40 41 1)
pdesetbd(25,...

'airs..

1R

'65')
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'dir',...
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s

'65")
pdesetbd(2,...
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15
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'65')
pdesetbd(1,...

(dirsss

% Mesh generation:
setuprop(pde_fig,'Hgrad',1.3);

setuprop(pde_fig,'refinemethod','regular’);

% PDE coefficients:
pdeseteq(2,...
'0.001',...

08
'(0)+(0).4(0.0)'...
'(1.085).*(3.68)’...



timerange,...

1305

'0.0',...

'[0 100])
setuprop(pde_fig,'currparam’,...
['1.085';...

13,68 1

'0.001...

'0.0 ')

% Solve parameters:
setuprop(pde_fig,'solveparam’,...
str2mat('0','5118','10''pdeadworst’,...

'0.5''longest','0','"1E-4' " ‘fixed','Inf))

% Plotflags and user data strings:
setuprop(pde_fig,'plotflags'[11111111000511000 0 1)),
setuprop(pde_fig,'colstring',");

setuprop(pde_fig,'arrowstring',");
setuprop(pde_fig,'deformstring’,");

setuprop(pde_fig,'heightstring',");

% Solve PDE:
pdetool('solve’)
ui=get(ax,'UserData’),

u2=get(u1,'Cdata’),

11



ux=get(u1,'Xdata');
uy=get(u1,'Ydata'),
u3=min(u2(:));
figure(pde_fig);

clf reset

close

12
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CHAPTER 1: INTRODUCTION

1.1 Welcome

Welcome to Scientific Visualization of Bioheat Process in human body. This
system is specially designed to computerize the management and visualizing process in
temperature in human body. This system also is a user-friendly application, has
meaningful icons and easy to use. All the system functions can be easily executed by a

simple click.

1.2 About This Manual

This manual will introduce you to visualizing system and provide all information
you need to use this system. This is the user manual that gives some simple instruction
and guide for the user. This manual can helps users used the system more easily. Every
function found in the system will be described in the manual. With using this manual,

users will not get lost and will be able to use the system accurately.

Who Should Use This Manual
This manual will intended for the following categories of users:
e Department Physical (cancer specialist)

e Patient as a user



1.3  Introduction to the system

Scientific Visualization of Bioheat Process System is a system that is developed
based on the visualization concept. This system consists of two modules that are Main
Menu and Visualization. The mainly purpose of the visualization module is to help user
to obtain view and visual effects and also in the future it can be helpful to doctor to
detect the patient’s symptoms because the system can give them views easy to see their
temperature.

There are several sub modules in the Scientific Visualization of Bioheat Process
system which are login, help, and visualization for non-expert user and draw
geometry, set boundary, and set the values in PDE specification and various
visualization to expert user. More details about those modules will be found in the

following chapter.



CHAPTER 2: SYSTEM REQUIREMENT

In this chapter, the hardware requirement and also the software requirement used
to implement the whole system have been listed. Users have to fulfill the minimum
requirement before using the system. There are some minimum requirements before
users can start using the system that is mean the user must install the software before use

this system. The hardware and software requirement are listed as follow:

2.1 Hardware Requirement
» Pentium 4 1.8 GHz Processor or above

256 MB DDRAM or above

v

» 40 GHz Hard Disk or above

2.2  Software Requirement
» Any Microsoft Windows Operating System

MATLAB 6.5

v



CHAPTER 3: GETTING STARTED

In chapter 3, steps have been listed to help users to start using the system. Users
have to follow the steps stated in this chapter in order to start using the system. All this
steps guide the users so that they will not get lost in using the system. There are several
steps that are needed before starting using the Scientific Visualization of Bioheat
Process. Those steps are listed as follow:

» Setup the system in your computer - copy from the cd into work, drive C at

MATLAB program

» The main page of this system showed as follow:

Scientific Visuahzation

Human Body Temperature

Welcome,

The buttons in this window will launch
for tequiremants users and i is & very
uselul tool for visuakzing the temper ature

In whole human body but in this system
R will locus temperature in human body
through Toreatm-hands

Copyright © 2004 by Fosnans Flamin supervisad by Prol Madya Dr Rosiali binti Zsrwiddin

Figure 3.1 User Interface Design of Scientific Visualization of Bioheat Process System



CHAPTER 4: FUNCTION SECTION

In this chapter, the services found in the system will be illustrated. Every service
with their particular interface will be listed to give users a clearly guide in using the
system.
» Then you will come to the main page of the Scientific Visualization module as
shown below.

» To choice the function that are needed, just click on the button in the left menu.
There are several sub-functions inside each of the main services, When clicking
on the button in the left menu, it will go to the module that you choose.

> Before you use this system you must get the login name from the expert user

first.

o

; Submit I Reset |

Figure 4.1 Login for the user

After you enter the login name, click the submit button and the page will display

depends on the user. The reset button will reset the name of login.



Figure 4.2 The expert user’s page

Figure 4.3 The non-expert user’s page
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» This module displays the system options.

System Options

Figure 4.4 The system option page

o When you click the Help button this page will display
Matlab  PDE Toolbox w W“ Cb. '
HELP

Welcome Scientific Visualization
of Bioheat Process System.

This system Is specially designed to computerize !
the management and visualizing process in the
temperature In human body This system Is a user~
friendly application, has meaningful icons and easy
10 use. All the system functions can be easlly
executed by a simple click,

This help pages provide all information user need
to use this system. And also to give the end user more
information about the specification and the user guide

for this system The user manual can be categorized
Into system specification and user guide in using the Y
system.

Figure 4.5 The help page

e There are four sub page to display information the different topic
which are about MATLAB, PDE toolbox, Bioheat and User

Guide.

e You can simply click on the topic to get the information,



> When you click the exit button this page will display:

m ’WW

Are you sure you want to exit?

Yes ] No I

Attt oo

Figure 4.6 Confirm close page
e Click Yes to exit the system.

e Click No to cancel.

Expert User

As the expert user, you can change the geometry and then the value of

parameters by click on the visualization editor or pdetool button.

{ e No. . » g 1
File Edt View Insert Tools Window Help
DSE& NAI2?/ 2PD
Time:1 Boundary'65 g Time:25.76 Boundary 65
06
0
086 L
Nt 0 3
p Time 60.5 Boundary 65 i Time 100 Boundnryas
05 05
0 0
08 08
3 0 2 2

Figure 4.7 The final result



Infor Sebect 8 new ploL o changa moda 10 ale FOE. e, o« boundaies | mpavd

Figure 4.8 pdetool page
To start solve and change the 2D temperature profiles of the hands human body

using pdetool GUI is describe as below:

First, start the Matlab PDE toolbox
o Start Matlab

« Type >> pdetool to start graphical user interface. This page will display:

lmumwwmmmnmm

o @o PN

ey e S T T ST
1 T Y T T T

08}
o6}
04}
02}
of
02} 1
04}
06
a0

s \ T3 0 o6 Y 14
‘ Inta D 20 govessiny, |

Figure 4.9 Default pdetool Enviroment



Second, specify the PDE
o In toolbar or in Options->Application, select problem type, e.g., generic scalar,
structural mechanics with plane strain, heat transfer etc. in this system use the
heat transfer mode.
Third, specify the domain
o Use Options->Axes Limits... to set displayed (x,y) area
o Recommended: use Options->Grid, Options->Grid Spacing, Options->Snap to
automatically snap to grid points
« Draw primitives (rectangles, polygons, ellipses) from which to build up domain
by addition/subtraction
o Polygon: For each side, drag mouse with held left button from starting
point to end point
o Circle: click on the button with the ellipse with **+", then drag the mouse
with held right mouse button
« Above plotting area, type in formula how to combine primitives by

addition/subtraction to form desired domain, e.g. C1-SQI

X-axis Inear spacing:

' 150518

Xeaxis extia ticks:

Y-axs lnear spacing.

| 1021

Heanis tange:
|[1.515)

Y-axis range:
{11

Figure 4,10 Axis Limit Figure 4,11 Grid Spacing
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Pio Eon Options Draw Boundsry PUE Mesh Solve Mot Window Hel
0 @O » O dh| - a
Set fommda 120 2o MERE]

06}

061

g 1 I i "
-‘5 A 06 0 0s 1 15
Info. Clck 1 select boundaries. Double-chck 1o open boundary condition dalog box | _e= |

Figure 4.12 Draw Mode

Fourth, specify boundary conditions
« Enter boundary mode by clicking on 'd Omega" button or selecting Boundary-
> Boundary Mode
o select
o one boundary segment by clicking on it
o several boundary segments by Shift-clicking
o all boundary segments by Ldit->Select All,
Then select Boundary->Specify Boundary Condition to specify boundary

condition for this segment or group of segments



Figure 4.13 Boundary condition

Fifth, specify PDE specification
e In PDE->PDE specification:
o Select Elliptic, Parabolic, Hyperbolic or Eigenmodes. For this situation,
use the parabolic equation to solve.

o Enter value in the field at PDE specification

R e emm————— e

Faion T adTI-oh T 1) Totompmanas
Type of PDE: © || Coefficient Value Description
 Elptic A o ) Deraty
@ Pasbole C 8 Hoal capacty
£ etk " k {00 Coull, of heat conduction
ﬁ\f””’?“"‘" Q |o Heat source
3 h |'o"— Conv. heat harster conll.
s Tot L R Extemal tomparalurn
Srcoese] e
—

Figure 4,14 PDE Specification
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Fifth, Specify initial mesh, desired mesh refinement
o In Mesh->Parameters choose desired maximum edge size, Inf for coarsest
possible mesh
« To generate initial mesh, click on triangle button or select Mesh->Initialize Mesh
e In Solve->Solve Parameters: Recommended: Select Adaptive mode, enter

desired maximum number of triangles or maximum number of refinement steps

Figure 4.15 Solve Parameters

[Pho 7 Options Cvaw Boundary POE Mosh Sohe Pot Window e
) -

Sot lomusa R o2 F 2o RO+ e lioli o2

1 v r ™ T T

05

V
0 3 % ."
\ < Y, '
u'%" ¢mA
i'i"#%
: K AN A
05} X 1%& ¢ 4 g

‘ A " 4 A A

A8 A 06 0 0s ! 16
ks ol o foge mneh, bl i revdos ard Wi oy s by kot |

Figure 4,16 Mesh Initialization
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Sixth, Specify desired plot
Click on Button with mesh surface or select Plot->Parameters. Recommended: Select

Show mesh, Colormap jet

Plot iype: Propedy User entiy. Plot style:

4 [Wmoweds Ff ] [empeiaied shad

I~ Contow

I~ Anows |tomperatire gradent = | | propotional

I~ Detomed mesh |1ompesature gradient = |

I™ Height (30 plot) |temperature = | | continuous

I~ Anmation Oplions . |

I~ Plotinxy gd Contou plot levels: |zn ¥ Plol sohsion sutomehcaly

I~ Showmesh Colormag: = L [~
A | _ Doe | _Coed |

Figure 4.17 Plot Selection
Finally, Solve PDE
Push the ''=" button or select Solve->Solve PDE. In adaptive mode the number of
triangles at each refinement step is shown in Matlab window. After the solution is found

the specified plot is shown.

Time=20 Color T

1 "
15 | 0s 0 0s 1

Vo Sabend @ e gk v fonie b ke FOE, mneh, 1 nssbores |

Figure 4.18 Final Solution (t= 20 sec)
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Non-Expert User

As the non-expert user, you see the visualization when you click on the view

visualization button and then, this page will display:

B Vi lization ot difforant thne ' - Woe
View of temperatine dutrbubon fookon bar in Celcns) ot vanous e reervas
’Timzt Boundary: 150 Specific Heat 3 68 u’mzs.rs Bouncary: 150 Specifc Heat 268
140 140
08 120 08 120
1o 1m0
o 0
{8 08
40
'1.7 ] 0 1 2 g K] 0 1 F
‘I;h.:lli Boundary 150 Speciic Heat 3 68 r‘mzm Boundary 150 Speciic Heat 350 1
140
o8 120 05
0 100 4 ol
08 08
| 9 1 Chve. l
2 1 0 1 2 “ 0 1 2

Figure 4.19 Result in different time

(VGG B ——
Viewe ol tompersiure detation [cokn bar 1 Celons] o) vasour bounday lempetshse
r:mmsmmm@)gm : Tina 26,75 Bounday 100 Spochc Hest 368
¢ 1
48
0s @© 0s
0 0 m
42
s Bl
) ' "
7 T B T | P Y T PR
rznzrsm.mmhmw
Descrgton 140
ALthe e 2575 1ac, more Sanunt wat bum and the ings
o e howiey Ursves are 4050 ook of bouesdaey 0 06 120
AL e 29575 anc o lnsums wa bum anvd the « 100
of the hoateg bwms e 00100 cobna of Loy 0
ALthe B 25 75 sec. more feamt wat bum and the
of e mateg lvums w105 150 onkonn o borndary | : 08
F y e Yo e wi o N

Figure 4,20 Result in different boundary temperature
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CHAPTER 5: SUMMARY

The user manual focus like others is to provide the user the most ample
knowledge which gives the most insights of the Scienntific Visualization and module.
This is to enable the user to have a more vivid view and understanding what the

Scientific Visualization of Bioheat Process System does and how it functions.





